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Foreword
This software reference guide provides information about the Analyst® software features.

Related Documentation
The guides and tutorials for the instrument and the Analyst software are installed automatically 
with the software and are available from the Start menu: All Programs > AB SCIEX > Analyst. A 
complete list of the available documentation can be found in the online Help. To view the Analyst 
software Help, press F1.

Technical Support
AB SCIEX and its representatives maintain a staff of fully-trained service and technical 
specialists located throughout the world. They can answer questions about the instrument or any 
technical issues that may arise. For more information, visit the Web site at www.absciex.com.
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1
Terms and Concepts
Analyst Software Modes
The software is divided into modes, which are discrete functional areas you can perform a range 
of activities related to a main task. You can access modes through the Navigation Bar or the 
Mode list in the toolbar and can switch from one mode to another without losing any work. For 
more information, see the Analyst® software Show Me tutorial.

Analyst Software Features
As well as the main features of acquisition and processing, the software has some features that 
help you run your experiments more efficiently and more quickly.

Figure 1-1  Analyst Software Window

Item Description
1 Mode list

2 Navigation Bar

1

2
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Terms and Concepts
IDA
IDA (Information Dependent Acquisition) is an acquisition method that analyzes data during 
acquisition. You can use IDA to change the experimental conditions depending on the analysis 
results. These real-time changes are controlled by criteria set in the acquisition method, 
including:

• Ion intensity and charge state.

• Inclusion and exclusion lists.

• Isotope pattern.

Being able to optimize data acquisition settings while the data is being acquired enables you to 
conserve both the sample and working time on an instrument. 

Queue Manager
The Queue Manager shows queue, batch, and sample status and lets you manage samples in 
the queue. 

Library Search
Library Search lets you create and manage a mass spectra database by helping you to search 
for and match unknown spectra against the mass spectra stored in the database.

Fragment Interpretation Tool
The Fragment Interpretation tool helps you interpret MS/MS data. Given the chemical structure of 
a molecule, this tool can generate a list of theoretical fragment masses from single non-cyclic 
bond cleavage of that molecular structure. The tool can then match the theoretical list with peaks 
in the current mass spectrum.

Express View
Use Express View when you want to create a batch quickly or when you need to add a sample 
name or change a small number of fields to an existing template. It provides a simplified interface 
for sample submission, while restricting further access to other functions. To use Express View, 
you select a batch template, type user information, and then submit a batch.

Workspaces
A workspace is a particular arrangement of windows and panes, including any associated file or 
files. For example, while working on a particular data set, you have opened and sized various 
windows to help you with your analysis. You can save this arrangement, or workspace, so that 
the next time you look at the data, the window arrangement is identical.

In Quantitate and Explore modes, you can have multiple workspaces per session. This means 
that you can design different workspaces to suit different tasks within these modes, and then 
save them for future use. When in one of these two modes, you can open a particular workspace 
without exiting that mode.
8                                                 Release Date: August 2011
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Analyst Service
The Analyst Service is the communication path between the mass spectrometer and attached 
peripheral devices.

The service is started each time you launch the Analyst® software. In general, however, the 
Analyst Service starts automatically when you log on to Windows. If for any reason the service is 
not running when you try to start the Analyst software, perhaps there was a problem starting the 
service at the time of log on, or if it was manually stopped, the Analyst Service will start up at that 
time. For this reason, starting or restarting the Analyst Service is almost always done 
automatically.

API Instrument Project Folders
The following are some of the folders found in the API Instrument project.

• API BioAnalyst: Contains the BTB Data Dictionary.csv file, the file containing the 
default Data Dictionary information required for the BioAnalyst™ software. The 
appropriate folders appear only when the BioAnalyst software is installed.

• Bundler: Contains a program that takes all aspects of a .wiff file and automatically 
combines them when the sample is completed.

• Configuration: Contains all the hardware profiles (.hwpf files). 

• Example Scripts: Contains some of the scripts that are used throughout the 
software.

• Instrument Data: Contains a file called InstrumentData.ins, which stores all the 
critical calibration information and more.

• Method Tables: Contains all instrument settings that define the enhanced scan 
functions. Do not change the files in this folder. Changing the contents of this folder 
will affect the performance of the enhanced scan modes.

• Parameter Settings: Contains all the instrument settings and linkages. Instrument 
settings are saved as ParamSettingsdef.psf files.

• Preferences: Contains the Tunedata.tun file. All settings (parameter, tuning, 
instrument, processing, appearances and queue) are saved as Tunedata.tun in this 
folder.

• Processing Scripts: Contains the scripts for data processing in Explore mode. They 
are found in the Script menu in the Analyst software.

• Queue Data: Contains information from the queue.

• Tuning Cache: Contains all the data created in Manual Tuning by clicking Start 
instead of Acquire. Files are saved with a generic time and date stamp for their 
names. The tuning cache holds a limited number of files and will overwrite files as 
needed. Rename and move the files immediately if they need to be saved.

Area Threshold Parameters
See Noise and Area Threshold Parameters on page 25.
Release Date: August 2011  9
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Autotune Instrument Optimization™ Algorithm
The Autotune Instrument Optimization™ algorithm tunes both quadrupole and LIT modes and 
performs mass calibration. For quadrupole mode, it adjusts the resolution offsets. For LIT mode, 
it optimizes AF3 and EXB. For MS3, it adjusts the excitation and isolation coefficients.

Background Subtract
Background subtract reduces the amount of noise in a spectrum by subtracting either one or two 
ranges that contain noise from a range that contains a peak. You can move the ranges 
independently or lock them and move them as a single entity within the graph. Locked 
Background Subtract is the preset setting. 

You can use background subtraction to isolate a peak of interest. You can highlight and subtract 
up to two selected ranges from your peak. You can also lock your ranges and move them within 
the graph to optimize peak isolation or to isolate another peak.

Background Subtract to File
You can use Background Subtract to File to save a new file that has a defined noise region 
subtracted from each scan. When a range is selected in the TIC, all the scans from that selection 
are internally averaged, and the resulting spectrum is subtracted from all the scans. Use the 
Background Subtract to File dialog to select where the file is to be saved. You also have the 
option of naming the new file. In some cases, the resulting file might look close to the original 
scan

Baseline Subtract
Baseline subtract removes a constant or slowly varying offset from a set of data. This is useful in 
locating small peaks that are obscured by noise. The software uses the following algorithm in 
performing a baseline subtraction.

1. Every data point in the data set is considered as the center of a window (in mass or 
time) with a user-definable width measured in amu or minutes.

2. The minimum values on either side of the current data point (minima) within the 
window are located.

3. A straight line is fitted between the two minima and the height (intensity) of the 
current data point above the line is calculated. The end points of the data are 
regarded as minima.

4. The data point is replaced with the new calculated value.

Batches
A batch is a collection of information about the samples that you want to analyze. Samples are 
usually grouped into sets to make it easier for you to submit them. Grouping your samples into a 
set also reduces the amount of data you must manually enter. A set can consist of a single 
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sample or multiple samples. All of the sets in a batch use the same hardware profile; however, 
samples in a set can have different acquisition methods. A batch can be submitted only from an 
acquisition station.

Batches link together:

• Sample information, such as name, ID, and comment.

• Autosampler location (rack information).

• Acquisition methods. 

• Processing method or script (optional).

• Quantitation information (optional).

• Custom sample data (optional).

• Set information.

Batch Editor
The Batch Editor is used for creating and modifying batches and for creating batch templates. To 
run samples, each using different acquisition methods, use the Batch Editor to select multiple 
acquisition methods in the same set. In the Batch Editor, you can also use an acquisition method 
as a template. In this case, the same method is used for each sample, but you can select 
different masses or mass ranges for each sample.

You can also modify every detail of the batch before submitting it for processing. When you 
submit a batch for analysis, you can submit the entire batch, specific sets within the batch, or 
specific samples within a set. 

For example, you may want to analyze ten samples, five using one acquisition method and five 
using a different acquisition method. You could create a batch of two sets, one for each method 
that you want to use. 

You can also use the Batch Editor to import sample lists created in external programs, such as 
Microsoft Excel. The Batch Editor has the following tabs:

Table 1-1 Batch Editor Tabs

Tab Description
Sample Used to create the sample list and to select sample details such as the sample 

name and the acquisition method to be used to acquire the sample.

Locations Used to select the positions of samples in the autosampler. Sample locations 
can be specified numerically in the Sample tab; however, the Locations tab 
provides a graphical interface for selecting sample locations. 

Quantitation Used to select the sample types and concentrations for quantitation batches. 
Because quantitation information can be specified post-acquisition in the 
quantitation Results Table, you do not have to use the Quantitation tab in the 
Batch Editor. Instead, you can use the Quantitation Wizard.

Submit Used to verify sample information and to submit samples to the acquisition 
queue.
Release Date: August 2011  11



Terms and Concepts
About Importing Batch Files
To make data entry easier, you can import batch file information from other applications. The 
Batch Editor can import text and other files that are formatted correctly. For examples of correctly 
formatted files, refer to the Batch folder in the Example project. 

The information in a batch file can also be exported for use with other applications, such as 
Microsoft Excel, Microsoft Access, and certain LIMS (Laboratory Information Management 
System) software.

Calculators
With the Calculator window, you can perform calculations on the basis of collected data. 
Although the calculator is a separate window, it is connected to the active graph within the 
software.

The following calculators are available.

• Elemental Composition Calculator

• Hypermass Calculator

• Elemental Targeting Calculator

• Mass Property Calculator

• Isotopic Distribution Calculator

You can cut and paste from one text box to another between the different windows in the 
calculators. You can also print data from any of the calculators by clicking the Print icon in the top 
left corner of the window. For more information about using calculators, see the Help.

Data from the Elemental Composition, Mass Property, and Isotopic Distribution calculators can 
be exported to a separate file. Use the Elemental Targeting calculator to modify the data within 
the active graph. Data from the HyperMass and Isotopic Distribution calculators can be overlaid 
on the active spectrum.

Elemental Composition Calculator
The Elemental Composition calculator determines potential molecular or amino acid 
compositions based on a target mass-to-charge ratio. You can type this ratio manually or select it 
from an active spectrum. This calculator creates a table with the possible element or amino acid 
combinations making up the mass of interest and the characteristics of each.

You can type or select values for such parameters as tolerance, electron state, and number of 
charges. You can also type a list of possible elements and put a limit on the number of each.

Hypermass Calculator
The Hypermass calculator determines the distribution of a multiply charged envelope based on 
an uncharged mass. You can select the uncharged mass, including the adduct and its polarity. 

Tip! You can set the precision of calculator data in the Calculators tab of the 
Appearance Options dialog. To open the dialog, click Tools > Settings > Appearance 
Options.
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The calculator displays a graphical representation of the Hypermass series, which can be 
overlaid onto the active spectrum. A list of the Hypermass data is also available. 

Elemental Targeting Calculator
The Elemental Targeting calculator reduces the data spectrum based on a specific pattern, 
primarily one corresponding to isotopic distributions. It can also search an MS data spectrum for 
a specific pattern of peaks, which can be entered either as a formula or as an isotopic 
distribution.

If the calculator finds a match, it creates a reduced plot containing only data pertaining to the 
specified pattern. For a spectrum, the calculator removes all unmatched data. For a 
chromatogram, the calculator calculates the elemental target for each of the underlying spectra 
and regenerates each point in the chromatogram on the basis of these new spectra.

Mass Property Calculator
The Mass Property calculator determines various properties such as exact mass, the average 
mass, the mass accuracy, and the mass defect of a mass of interest. The results generated by 
this calculator depend upon the number of input fields completed.

Isotopic Distribution Calculator
The Isotopic Distribution calculator determines the isotopic distribution based on an entered 
formula. This allows you to distinguish between compounds with the same mass based on 
relative intensities of isotopes. 

The calculated isotopic distribution can be displayed in graphical or text format on the Isotopic 
Distribution pane, overlaid on the active spectrum, or exported to a separate file.

Calibration Options
The calibration options define the parameters for a calibration curve, which are used to 
determine the calculated concentration of the samples. The curve is a plot of the concentration of 
the standard against the area or height of the standard if no internal standard is used. If an 
internal standard is used, the curve is a plot of the concentration ratio against the area or height 
ratio. This curve is used, along with the area (or height) for the unknowns, to interpolate the 
calculated concentration.

You must choose the best regression type or fit to fit the curve to the points and the best 
weighting factor for your project.

About Calibration Curves
The calibration curve is used to determine the calculated concentration of samples, including QC 
samples. It is a curve that results from plotting the concentration of the standard versus its area 
or height, or ratios, if you are using an internal standard. The area or height of a sample is then 
applied to this curve to determine the sample concentration, as displayed in the Results Table. 
The regression equation generated by this calibration curve is used to calculate the 
concentration of the unknown samples.
Release Date: August 2011  13
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The software places the known concentrations (or ratios) on the x-axis and the calculated area or 
height (or ratios) on the y-axis. It then plots the points for all the standards in the batch. The 
system produces a best-fit curve to those points through regression and weighting type that you 
choose. This curve is used, along with the area (or height), for the unknowns to interpolate the 
concentration.

Selecting the Best Regression Type
After you select a regression type (fit), you cannot see the calibration curve from the wizard. 
Instead, you may use the preset values, rely on your experience, or use your corporate policy to 
choose a regression type.

After you change the fit, check the Accuracy column in the Results Table for changes. You will 
find that the better the fit is, the better the accuracy of the quantitative analysis will be.

The calibration curve plots the standards concentration against its peak area or height (or ratios, 
if an internal standard is used). When the points for the standards are plotted, determine the best 
fit for the curve to these points and indicate your choice in the Specify Calibration dialog of the 
wizard. The preset fit is linear, which assumes that all your standards will fall on a straight line. 
Select from the types of fit in Table 1-2.

Choosing the Best Weighting Factor

The calibration curve plots the standards concentration against its peak area or height. When the 
points for the standards are plotted, you must determine the best weighting factor for these points 
and indicate your choice in the Specify Calibration dialog. The default fit is None, which assumes 
that all points along the curve have the same importance. Select from the types of weighting in 
Table 1-3.

Table 1-2 Types of Fit 

Fit Description
Linear Linear regression assumes that the standard points fall on a straight 

line.

Linear Through Zero Linear Through Zero regression assumes that the standard points fall 
on a straight line and that the points line up with the zero point on the 
x- and y- axes. Use this setting to force the line to go through the zero 
point.

Quadratic If the standard points do not fall on a straight line, use quadratic 
regression to produce a quadratic fit to the data points.

Mean Response Factor If the standard points fall on a straight line and you want to average 
the points, use mean response factor regression to produce an 
average of the slope for every point on the curve.

Power If there is some linear and some curvature in the line of points, use 
power regression instead of linear or quadratic regression to produce 
a line somewhere between these fits.

Table 1-3 Types of Weighting 

Weighting Description
1/x To place some additional emphasis on lower-value points, use a weighting 

factor of 1/x. 
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Chromatograms
A chromatogram displays the variation of some quantity with respect to time in a repetitive 
experiment; for example, when the instrument is programmed to repeat a given set of mass 
spectral scans several times. Chromatographic data is contiguous, even if the intensity of the 
data is zero. Chromatograms are not generated directly by the instrument, but are generated 
from mass spectra.

In the chromatogram display, the intensity, in counts per second (cps), is shown on the y-axis 
versus time on the x-axis. Peaks are automatically labeled. 

In the case of LC/MS, the chromatogram is often displayed as a function of time, the time at 
which a particular scan was obtained, which can be derived from the scan number.

Compound Database
The compound database stores information about compounds, including optimization 
specifications. 

Use the compound database when you have large numbers of samples and need to optimize a 
large number of compounds quickly. The Automaton software automatically fills the database. 
The Compound Database window stores optimized conditions for compounds that can be 
retrieved to run samples.

Compound Optimization
The Compound Optimization software wizard automatically optimizes an analyte. You can 
introduce the sample using infusion or FIA (flow injection analysis.) The software first checks for 
the presence of the compounds. The voltages of the various ion path parameters are gradually 
increased or decreased to determine the maximum signal intensity (Q1 scan) for each ion. A text 

1/(an) Use a weighting of 1/x2 to place much higher emphasis on lower-value 
points.

1/y Use a weighting factor of 1/y when you are calibrating by the area (y-axis) 
rather than by the concentration (x-axis), and you want to place some 
emphasis on lower-value points. A weighting of 1/y is a variant of 1/x where y 
and x should be proportional to each other. 

1/(y*y) Use a weighting factor of 1/y2 when calibrating by the area (y-axis) rather 
than by the Concentration (x-axis), and you want to place much higher 
emphasis on lower-value points. A weighting of 1/y squared is a variant of 1/
x squared where y and x should be proportional to each other.

In x Use the logarithm of x to place more emphasis on higher-value points.

In y Use the logarithm of y to place more weight on higher-value points. Use 
when calibrating by the area (y-axis) rather than by the concentration (x-
axis).

Table 1-3 Types of Weighting  (Continued)

Weighting Description
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file is generated and displayed during the optimization process. This file records the various 
experiments performed and the optimal values for each ion optic parameter. A file folder 
containing all the experiments performed is also generated and can be found by opening the data 
file folder in Explore mode. For each experiment performed, an acquisition method is also 
generated and saved in the acquisition method folder.

See also Flow Injection Analysis (FIA) on page 17 and Infusion on page 19.

Dynamic Background Subtraction™ Algorithm
Dynamic Background Subtraction™ algorithm improves detection of precursor ions in an IDA 
(Information Dependant Acquisition) experiment. When the algorithm is activated, IDA uses a 
spectrum that has been background subtracted to select the ion of interest for MS/MS analysis, 
as opposed to selecting the precursor from the survey spectrum directly. Because this process 
takes place during LC analysis, the algorithm enables detection of species as their signal 
increases in intensity, therefore focusing on detection and analysis of the precursor ions on the 
rising portion of the LC peak, up to the top of the LC peaks (maximum intensity).

Dynamic Fill Time
Dynamic Fill Time (DFT) is a feature specifically designed to optimize the data obtained in every 
spectrum for the linear ion trap scan functions. DFT will automatically adjust the fill time used to 
fill the ion trap based on the ion flux coming from the source. For more intense ions, the fill time 
will be automatically reduced to ensure the trap is not overfilled with ions.

For less intense ions, the fill time will be automatically increased, ensuring that good ion statistics 
are obtained in the spectrum. DFT is applicable for the following scan types: 

• Enhanced MS (EMS)

• Enhanced Resolution (ER)

• Enhanced Product Ion Scan (EPI) 

• MS/MS/MS (MS3) 

You can adjust the DFT settings by selecting Tools > Settings > Method Options in the Analyst 
software. 

Experiments and Periods
The mass spectrometer acquisition method consists of experiments and periods. In the 
Acquisition Method Browser pane, you can create a sequence of acquisition periods and 
experiments for the mass spectrometer. You can also open a method previously created in the 
Tune Method Editor.

Experiments
An experiment includes the mass spectrometer settings and scan type during an MS scan. A set 
of MS scans performed for a specific amount of time is called a period. An acquisition method in 
which the MS parameters and actions are the same through the entire duration is called a single-
period, single-experiment method.
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In looped experiments, MS settings are changed on a scan-by-scan basis. For example, if the 
sample contains two compounds, A and B, you may want to loop an MS/MS experiment of 
compound A with an MS/MS experiment of compound B to obtain information on both 
compounds in the same run. The mass spectrometer method will alternate between the two 
scans. Other examples of looped experiments include alternating between positive and negative 
mode in a run and IDA methods. 

Periods
A period can contain one or more looped experiments. In a multi-period acquisition method, 
experiments are performed for a specified amount of time and then switch to another set of 
experiments. Periods are useful when you know the elution time of the compounds in an LC run. 
You can have the mass spectrometer perform different experiments according to when the 
compounds elute to get as much information as possible in the same run.

In Figure 1-2, a three-period method is shown. The first period has a duration of 3.015 minutes; 
the second period is 4.986 minutes; and the third period is 7.000 minutes.

Figure 1-2  Example of a multi-period experiment 

Flow Injection Analysis (FIA)
FIA is the injection of a small quantity of a sample by an autosampler into the LC stream. During 
the FIA optimization process, multiple sample injections are performed for various source- or 
compound-dependent, or both, parameter types that are changed between injections. FIA 
optimizes for declustering potential, collision energy, and collision cell exit potential by performing 
looped experiments in succession, that is, one compound-dependent parameter followed by then 
next compound-dependent parameter. It optimizes for source-dependant parameters by making 
an injection for each parameter.

Use FIA optimization to optimize both compound- and source-dependent parameters using LC at 
higher flow rates. See also Infusion on page 19.
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IDA Explorer
The IDA (Information Dependent Acquisition) Explorer is used to display data acquired through 
an IDA method. 

The IDA Explorer can be turned off and on by going to the IDA Explorer tab in the Appearance 
Options dialog. Columns present in the List View can be defined under this tab as well.

The left side of the viewer shown in Figure 1-3 displays the masses on which a product ion scan 
was performed. In this area, you can examine the mass, intensity, time, and collision energy of 
ions on which product ion scans were performed. You can view these in either a list view or a tree 
view. In list view, the list can be sorted by double-clicking on any column header. In the 
Appearance Options dialog, you can customize the columns you want to view in the list view. 

On the right side, the viewer is split into four panes. The top left pane displays the survey TIC 
data. The bottom left pane shows the XIC of the mass. The top and bottom right panes show the 
survey and product scans, respectively.

The IDA viewer lists all the masses on which Enhanced Product Ion scans or Enhanced 
Resolution scans were performed. Click a mass in the list or tree view to display plots relevant to 
that mass. You can view the survey spectrum from which the mass was identified and the product 
spectrum of that mass. It also displays the TIC of the survey scan and the XIC for each mass.

Figure 1-3  IDA Viewer

Note: Brackets around a mass indicate that the mass is merged. A merged mass is 
contiguous across a number of cycles. When a merged mass is displayed, it indicates 
an averaged spectrum, containing the average of all contiguous spectra.
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IDA Methods
An IDA (Information Dependent Acquisition) method automatically runs experiments based on 
results obtained from previous experiments. Use IDA criteria to optimize data acquisition settings 
while acquiring data to reduce the sample acquisition time in a single injection. With IDA, you can 
conserve both the sample amount required and working time.

Create an IDA method with up to two survey scans and eight dependent scans in a single 
experiment. A survey scan is used in IDA to trigger additional experiments. You can use the 
following scans as a survey scan:

• Enhanced Multiply-Charged (EMC).

• Enhanced Product Ion (EPI) (second survey scan).

• Enhanced MS (EMS).

• MRM.

• Neutral Loss (NL).

• Precursor Ion (Prec).

• Q3 MS.

You can use the following dependent scans:

• EPI.

• MS/MS.

In an IDA experiment, the mass spectrometer actions are varied from scan to scan based on the 
data acquired in a previous scan. The software analyzes data as it is being acquired and then 
determines the masses on which to perform dependent scans. You can set the criteria that will 
activate an IDA experiment and the method parameters to be used. 

IDA experiments modify experiments and improve results based on the following user-defined 
criteria:

• Ion intensity and charge state.

• Inclusion and exclusion lists.

• Isotope pattern.

• Dynamic exclusion.

• Rate of change in ion intensity (See Dynamic Background Subtraction™ Algorithm 
on page 16).

Infusion
Infusion is the continuous flow of the sample at low flow rates into the ion source using a syringe 
pump. During the infusion optimization process, the software can select precursor and product 
ions and optimize for declustering potential, collision energy, and collision cell exit potential for 
both. The voltages of these ion path parameters are gradually increased or decreased to 
determine the maximum signal intensity for the precursor and product ions.

Use infusion optimization to optimize compound-dependent parameters only at much lower flow 
rates than those used during LC/MS analysis. See also Flow Injection Analysis (FIA) on page 17.
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Integration Algorithms
The Analyst® software has two integration algorithms: the original Analyst Classic integration 
algorithm and the IntelliQuan integration algorithms. The IntelliQuan algorithm provides more 
consistent peak-finding and integrated functionality, with fewer parameters that require 
adjustment.

Analyst Classic and IntelliQuan Integration Algorithms
The IntelliQuan algorithm uses one of two peak-finding parameters: Automatic IQA II, which is a 
parameterless setting, or Specify Parameters MQ III. After integrating peaks using the IntelliQuan 
algorithm, you can choose which peak-finding parameter best fits the data set. This is done in the 
displayed peak integration parameters in the Peak Review pane or window. 

Table 1-4 shows the parameters available with the Analyst Classic algorithm.

Table 1-5 shows the parameters available with the MQ III algorithm, but not the IQA II algorithm.

Table 1-4 Analyst Classic Algorithm

Parameter Definition
Default Bunching Factor The number of points to be averaged together and 

considered as a single point for the purpose of peak-finding. 

Default Number of Smooths The number of times to smooth the chromatogram.

Default Void Volume Retention 
Time

Any peaks that appear before this time are ignored.

Default Concentration Units The concentration units used to describe the sample 
concentration, for example, pg/µL.

Default Calculated Concentration 
Units

The concentration units used to describe the calculated 
sample concentration, for example, pg/µL.

Default RT Window The time window centered at the expected retention time for 
peak-finding. For example, a 30 second retention time 
window gives an additional 15 seconds before and after the 
expected retention time.

Table 1-5 MQ III Algorithm

Parameter Definition
Default Noise Percentage The threshold used in peak-finding. Only peaks higher than 

this specified percentage will be detected.

Default Baseline Subtraction 
Window

A time window around each data point that is used to 
determine the height of the baseline correction to be applied 
to that point. This time window helps remove excessive 
noise from the chromatogram. The baseline is defined as 
the line connecting the point of minimum intensity on the left 
side of a given data point to the point of minimum intensity 
on the right side, within the specified window.
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Table 1-6 shows the parameters available for use with both IntelliQuan algorithms.

Interface Heater Temperature (IHT) 
The IHT parameter controls the temperature of the NanoSpray® ion source interface heater. The 
optimal heater temperature depends on the type of sample you are analyzing and the solvent 
used. If the heater temperature is too high, the signal degrades. The maximum heater 
temperature you can set is 250 °C, but this is too high for most applications. Typically, heater 
temperatures are in the 130 to 180 °C range.

LC Methods
If you are creating a new acquisition method file from an existing file, you may decide to use 
some or all of the device methods in the acquisition method. With the Acquisition Method Editor, 

Default Peak-Splitting Factor Controls whether a given peak cluster consists of multiple 
adjacent peaks or one (possibly noisy) peak. If the intensity 
dip is less than the value specified, then a single peak is 
reported; otherwise the point with minimum intensity in the 
dip splits the cluster into two separate peaks. Setting a large 
factor will prevent clusters from being split into more than 
one peak.

Default Void Volume Retention 
Time

Any peaks that appear before this time are ignored. 

Report Largest Peak Selecting this parameter returns the largest peak in the 
retention time window. If this parameter is not selected, the 
closest peak to the expected retention time is found. The 
expected retention time is automatically calculated in the 
Quantitation Wizard.

Table 1-6 IntelliQuan Algorithm

Parameter Definition
Default Minimum Peak Height The minimum height of a peak required for peak integration.

Default Minimum Peak Width The minimum width of a peak required for peak integration.

Default RT Window Specifies the time window centered at the expected 
retention time for peak-finding. For example, a 30 second 
retention time window gives an additional 15 seconds before 
and after the expected retention time.

Default Smoothing Width The number of points used in data smoothing.

Default Concentration Units The concentration units used to describe the sample 
concentration, for example, pg/µL.

Default Calculated Concentration 
Units

The concentration units used to describe the calculated 
sample concentration, for example, pg/µL.

Table 1-5 MQ III Algorithm (Continued)

Parameter Definition
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you can customize the acquisition method by adding or removing HPLC peripheral device 
methods. 

You can create an acquisition method for an HPLC peripheral device means by selecting the 
operating parameters for that peripheral device. Methods can be created for any of the following 
peripheral devices if they are configured in the active hardware profile:

• Pumps.

• Autosamplers.

• Syringe pumps.

• Column ovens.

• Switching valves.

• Diode array detector.

• Analog-to-digital converters.

• Integrated systems. 

For information about setting properties for peripheral devices, see the Peripheral Devices Setup 
Guide.

Library Databases
The Library Search feature compares unknown spectra to known MS spectra contained in a 
library database and generates a list of possible matches. 

With Library Search you can:

• Compare library contents against an unknown spectrum.

• Add records to the library.

• Edit existing records.

You can store library data in the following locations:

• MS Access on a local database. 

• MS SQL Server.

Before you can use the Library Search feature, determine where the library database is stored 
and connect your computer to that location. Library databases can be stored locally and over a 
network.

To connect to a database, use an alias. In this case, the alias specifies a connection to a specific 
database and may include the user name and password required to access the database. For 
example, you may have a small library database of your own identified compounds on your 
computer and your organization may have a central database that you use occasionally. Creating 
aliases for each database allows you to switch between them quickly. For information about 
creating aliases and connecting to databases, see the Help.

Method-Creation Tools
The software offers four quantitation method-creation tools, each of which creates a fully 
functional method. The best choice of tool depends on the tasks you need to accomplish.
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Wizards
There are two available method-creation wizards: the Standard Quantitation wizard and the 
Automatic Quantitation wizard. Both allow you to select the batch or batches to be quantified, 
create or select a quantitation method, and then integrate the sample data. 

The difference between the two is the type of method you create. The standard wizard creates a 
standard method, while the automatic wizard creating methods. You do not verify the peaks as 
part of the method creation (you can still review the peaks after integration has taken place).

There is only one common occasion for which you would not need to verify the peaks: when you 
are doing quantitation simply to integrate, not to find concentrations. You might want to do this, 
for example, if you have a batch that contains different compounds in every sample, or when the 
mass is not the same from sample to sample. If this is the case, use the automatic wizard. 
Otherwise, to perform quantitation, use the standard wizard.

Use the Standard Quantitation wizard after you have acquired your sample and you want to:

• Choose a representative sample.

• Select analyte and internal standard peaks.

• Adjust peak-finding and integration parameters. 

• Review peaks during method creation. 

• Select calibration.

Use the Automatic Quantitation wizard to select a batch, create a method (without peak 
confirmation), and then integrate the sample data. This wizard is quicker than the Standard 
wizard and does not require that the masses scanned be the same for all samples. It does not, 
however, allow you to select an internal standard—all ions are treated as analytes.

Use the Automatic Quantitation wizard after you have acquired your sample and you:

• Want to select calibration.

• Do not want to adjust peak-finding and integration parameters.

• Do not want to select analyte peak names.

• Do not want any internal standards.

• Do not want to review peaks during method creation, or you have different 
compounds in every sample.

When you are only integrating peaks, you do not need to verify them as no concentration 
calculation is required. In this case, use the Automatic quantitation method creation, which allows 
you to review the peaks after integration has taken place.

Finding Peaks Using an Automatic Method

The software uses the standard peak-detection process, with the following exceptions:

• It uses the bunching factor and the number of smooths (from the wizard) as is.

• It calculates the expected retention time and noise and area thresholds separately 
for every peak.
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Quantitation Method Editor
Use this option after you have acquired your sample and you want to:

• Adjust peak-finding and integration parameters. 

• Select analyte and internal standard peaks. 

• Select calibration.

You can use the Quantitation Method Editor to do three additional tasks:

• Sum ions for integration.

• Use an internal standard from a different period or experiment (if the internal 
standard was acquired in a different period or experiment than the analyte).

• Edit an existing method.

The Semi-Automatic Method Editor
The Semi-Automatic Quantitation Method Editor is part of the Batch Editor. You can use the 
Semi-Automatic Quantitation Method Editor to select quantitation information, such as sample 
type and sample concentration, prior to data acquisition. This preparation makes performing 
subsequent quantitative analysis easier. Alternatively, you can select a full method in the Batch 
Editor, which is then automatically applied at the end of the batch run to generate the quantitation 
Results Table.

Use this option when you:

• Have not yet acquired any samples.

• Want to select names and masses for analyte and internal standard peaks.

• Want to select concentrations and sample types on the Quantitation tab in the Batch 
Editor, but do not have any other quantitation method. 

• Want to edit the quantitation method, if necessary, at a later time.

Finding Peaks Using a Semi-Automatic Method

The software uses the standard peak-detection process, with the following exceptions: 

• It uses the bunching factor (from the Quantitation Method Options dialog) and the 
number of smooths (from the Create Semi-Automatic Quantitation Method dialog) as 
is.

• It uses the most concentrated standard as the representative sample. To establish a 
retention time, it uses the largest peak within that chromatogram.

• To set noise and area thresholds, it uses the resulting baseline noise. (This process 
is identical to how the default values are set for peaks in normal methods.) These 
integration parameters are applied to all other samples.

• If the batch being examined does not contain quantitation information (sample type 
and concentrations), the retention time and thresholds are calculated separately for 
every peak (as for fully automatic methods).
24                                                 Release Date: August 2011



Software Reference Guide
Noise and Area Threshold Parameters
To identify peaks, the software requires a set of noise and area threshold parameters. The 
software sets these parameters initially, but you can change them later. It sets the parameters as 
follows:

1. The software calculates the largest intensity difference between any two sequential 
data points. This number represents the difference between two intensities, not the 
actual intensity itself.

2. For each sequential pair with an intensity difference of less than 5% of the value 
calculated in Step 1, it calculates the standard deviation (using a mean of zero) of 
the intensity differences. (The software does not use those pairs of points with an 
intensity difference larger than 5% of the maximum.)

It sets the noise and area thresholds as follows:

3. The noise threshold is equal to the standard deviation calculated in step 4.

4. The area threshold is equal to five times the noise threshold.

Recalculating the Noise and Area Threshold

If you define a new background area, the software recalculates the noise and area thresholds as 
follows. For each sequential pair of data points, the software calculates the standard deviation, 
using a mean of zero, of the intensity difference. The Analyst software uses all points within the 
selected range because you are explicitly telling it that the selected area is background noise.

It sets the noise and area thresholds as follows:

1. The noise threshold is equal to the standard deviation calculated for the selected 
range. 

2. The area threshold is equal to five times the noise threshold.

Peak Integration
The following are integration types by which the baseline was found and integrated when the 
peak was found.

• Manual: The peak was manually integrated by the user. 

• Automatic: The peak was automatically integrated as follows:

• Baseline-to-baseline: The peak area is defined by vertical droplines at the 
beginning and end of the peak which extend to the baseline. This integration 
type is possible only for peaks that do not have another peak immediately 
preceding or following.

Note: The minimum value for both the noise and area thresholds is 0.000001. If the 
calculations produce a value that is lower than this minimum, then the software resets 
the value of that threshold at 0.000001.

Note: The minimum value for both the noise and area thresholds is 0.000001. If the 
calculations produce a value that is lower than this minimum, then the software resets 
the value of that threshold at 0.000001.
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• Valley: Same as baseline-to-baseline, except that it applies only to peaks that 
do have another peak immediately preceding or following.

• Exponential Skim: The peak area is the main or parent peak in an 
exponential skim.

• Exponential Child: The peak area is the child peak resulting in an 
exponential skim.

Peak Review
During peak review you can survey the peaks that the software selected and then redefine the 
peak or the start and end points where necessary.

Reviewing Peaks
In general, the software is adept at accurately identifying analyte and internal standard peaks. 
For a variety of reasons, including sample acquisition and quantitation method definition, 
sometimes the software misses the correct peak, chooses the wrong one, or is unable to locate a 
peak at all. Other times, although the software may correctly identify the peak, you might not 
agree with the start or end points selected.

Detecting Peaks
The software detects peaks in four stages.

1. First, it finds the potential peak start by examining the distance between each 
bunched point and the preceding one. When the distance exceeds the current noise 
threshold, a potential peak start has been found.

2. Then it confirms the peak start by making sure that enough points exist in a row to 
exceed the area threshold.

3. Next, it finds the peak top by searching for a point that is lower than the previous 
point.

4. Finally, it finds the end of the peak by identifying the place where the distance 
between one bunched point and the next falls below the noise threshold. If 
necessary, it then separates peaks.
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Finding the Potential Peak Start
To find the potential start of a peak, the software measures the intensity difference between 
sequential pairs of bunched points, starting at the first point. When it finds a difference that 
exceeds the current noise threshold, the software declares the first point a potential peak start.

Confirming the Peak Start
To make sure that it has found a real peak, the software moves along the curve, adding the 
intensity difference between each bunched data point from the intensity at the potential peak start 
to a total sum. This process stops when the intensity difference between successive points is less 
than the noise threshold. This sum is an approximation of the area of the leading edge of the 
peak. If this sum exceeds the area threshold, then the software confirms the peak start.

Next, the software determines the actual start of the peak by moving backward from the potential 
peak start until it finds the lowest point in the peak. It moves back through five bunches of raw 
data. This point is the actual peak start.

Figure 1-4  Finding the potential peak start

Item Description
1 Exceeds noise threshold

2 Potential peak start

3 Does not exceed noise threshold

1

2

3
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Finding the Peak Top
To find the peak top, the software first looks for a point that is lower than the preceding point. 
Then, to confirm that it has found the top correctly, it sums the intensity differences between the 
potential top and subsequent bunched points until it reaches the end of the peak. If the total 
distance between points exceeds two-thirds of the area threshold, then the peak top is 
confirmed. That is, the software makes sure it has a peak first, and then works backward to find 
the top of it.

Figure 1-5  Confirming the peak start

Item Description
1 Sum of area slices greater than threshold

Figure 1-6  Confirming the actual peak start

Item Description
1 Look through data points in this region

2 Minimum data point

3 Potential peak start

1

3

2

1
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If, however, the software finds a higher bunched point before the area test has been passed, then 
it identifies a new top and restarts the area test.

Note: The actual retention time for a peak is not simply the point identified as 
described previously. Instead, it is determined from a quadratic fit based on the three 
highest data points.

Figure 1-7  Finding the peak top

Item Description
1 Sum of area slices is greater than two thirds of the area threshold

Figure 1-8   Identifying a new peak top

Item Description
1 The shoulder has a maximum, but the cumulative crest area is not greater than two 

thirds of the area threshold

1

1
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Finding the Peak End
The software declares a peak end point when one of the following occurs:

• The difference between two consecutive points fails the noise threshold test.

• The software detects the start of a new peak.

In either case, the lowest bunched point from the last five bunches is considered to be the actual 
end point of the peak.

In general, the software finds several peaks for each chromatogram. The peak it selects is the 
one whose retention time is the closest to the expected retention time, specified in the method. If 
no peak has a retention time within the specifications, the software marks the peak as not found.

Figure 1-9   Finding peaks

Item Description
1 The shoulder has no separate maximum point

Figure 1-10  Finding the peak end: case 1

Item Description
1 Exceeds noise threshold

1

1

2

3
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Separating Peaks
If a new peak begins before the current peak hits the baseline, the software decides, based on 
the following criteria, whether to resolve the baseline by using exponential skims. The skim 
passes under one or more peaks that follow the precursor. These peaks are called product 
peaks. 

When the software performs an exponential skim, it subtracts the area underneath the skim from 
the product peaks and gives it to the precursor peak. It then subtracts the small area above the 
skim from the precursor peak and adds it to the first product peak.

The software uses the following criteria to determine whether it will use exponential skimming:

• Exponential Peak Ratio.

• Exponential Adjusted Ratio.

• Exponential Valley Ratio.

2 Peak end

3 Does not exceed noise threshold

Figure 1-11  Finding the peak end: case 2

Item Description
1 Peak end

Figure 1-10  Finding the peak end: case 1 (Continued)

Item Description

1
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Program Files
The following folders are found within the Program Files\Analyst folder.

• bin: This folder contains the Analyst® software program files. Contents of this folder 
should not be changed, as this will affect the software functionality. 

• BioAnalyst Tutorial: This folder contains a tutorial that guides new users through all 
the features of the BioAnalyst™ software. There is also a multimedia overview of the 
BioAnalyst software.

• Firmware: This folder contains the instrument system controller software 
(scu21.exe) and the instrument firmware files. These files can be used to download 
new firmware to the instrument when required. For more information, see the 
software installation guide included with the software. 

• Help: This folder contains the help files, as accessed from the Help menu in the 
program, and the release notes.

• Scripts: This folder contains all the available scripts that can be installed.

• Simulation: This folder contains the instrument data files needed to run the software 
in simulation mode.

Figure 1-12 Separating peaks: an exponential skim

Item Description
1 This area is subtracted from the precursor peak and added to the first product peak

2 Exponential skim

3 Cluster baseline

4 These areas are subtracted from the product peaks and added to the precursor peaks

1

3

2

4 4
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Qualitative Data
You can view the information contained in a data file in table or graph form. Graphical data is 
presented either as a chromatogram or as a spectrum. You can view data from either of these 
displays as a table of data points, and you can perform various sorting operations on the data.

When you open a data file in the software, different panes appear depending on the type of 
experiment you performed.

If the MCA check box is selected in the Tune Method Editor, the data file will open to the MS 
(mass spectrum). If the MCA check box is not selected, the data file opens with the TIC. You then 
have to select a range and double-click in the TIC pane at a particular time to show the MS for 
this range. 

The software stores data in files with a .wiff extension. Wiff files can contain data for more than 
one sample. In addition to .wiff files, the software can open .txt files; .txt files contain data for only 
one sample.

Quantitative Analysis
Quantitative analysis is the process of determining the concentration of analyte in a sample; it 
occurs after the data acquisition phase.

Quantitative analysis is used to determine the concentration—the amount of analyte per 
volume—of a particular substance in a sample. By analyzing an unknown sample and comparing 
it to other samples containing the same substance in a known concentration (standard), the 
software can calculate the concentration of the unknown sample. The process involves building a 
calibration curve using a standard and then using it to interpolate the concentration for the 
unknown sample. The calculated concentrations of each sample are then available in a Results 
Table.

Quantitative Methods
A quantitative method can be created either before or after data acquisition; it is a set of 
instructions used to generate a quantitation Results Table. The quantitation method can include 
parameters used to locate and integrate peaks, generate standard curves, and calculate 
unknown concentrations. It can also include a query to sort the data.

Queries
A query is a method of selecting only those records that meet certain criteria. You can use 
queries to view particular parts of the data in the Results Table that interest you, based on textual 
or mathematical selections. 

When you use a query, the table displays only the rows of data that meet the criteria you select. 
All columns are displayed. You can further refine your selection by running a second query on the 
rows displayed by the first query.

Use pre-defined choices and typed entries to create a query that can be executed, saved, or 
modified. Each line of the query works like a Boolean search that runs against Results Table 
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columns to determine which records to display. Each line of the query selects only the records for 
display that meet its criteria. You can define a default or table-specific query.

Queries on Sample Type
If you design a query that selects only the standard sample type, the Results Table displays only 
those rows of data that contain Standard in the Sample Type column.

Default Queries and Table-Specific Queries
A default query is generally used to identify samples that do not meet certain criteria. A table-
specific query is generally used to identify records that meet certain criteria.

The default query is generally used to find problems with quality control or standards. If you 
select the concentration and maximum variation of the QCs and standards in the Quantitation 
Method Wizard, then the Results Table displays only those samples that lie outside this range. If 
the Results Table displays nothing, then the samples are all right.

Table-specific queries are run against a displayed Results Table to select records that meet 
certain criteria. Design these queries through the menu that is available when you right-click in 
the table. You can save and export a query to make it available for future Results Tables.

Table-Specific or Global Settings

When you are working with table setting options, you will notice procedures that are table-
specific or global.

• Table-specific settings: When you modify the table settings on the table itself, you 
are making changes to the settings that are available only to that table; however, you 
can export them as global settings. 

• Global settings: When you modify global settings, you are making changes to a 
group of settings that can be applied to future Results Tables. You can customize a 
Results Table that you are in the process of creating by choosing a group of settings 
on the Create Quantitation Set: Select Settings & Query page. If you do not choose a 
group of settings, the software automatically uses the default settings.

How Accuracy Variations Affect the Results
For default queries, accuracy is expressed as a percent and implemented as plus or minus that 
number. For example, if you type 10 for Maximum Variation for standards in the Create Default 
Query dialog, then all records containing standards whose accuracy falls outside 90% and 110% 
are displayed in the Results Table. If you typed 5, only standards whose accuracy is less than 
95% and greater than 105% would appear in the Results Table. For more information, see 
Results Tables on page 40.

Regression
This section gives the equations for each of the regression types. In the following equations, x, y, 
and w are as described in Weighting Factors on page 52.

In the following equations, x represents the analyte concentration for standard sample types, and 
y represents the corresponding peak area or height. The exact variables used for the regression 
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depend on whether or not an internal standard is being used and whether the peak area or the 
peak height is used as shown in the following table.

Where:

• Ca = actual analyte concentration

• Cis = internal standard concentration

• DF = dilution factor

• Aa = analyte peak area

• Ais = internal standard peak area

• Ha = analyte peak height

• His = internal standard peak height

Linear Regression
Linear regression assumes that the points of the standard fall on a straight line. 

The linear calibration equation is calculated as:

y = m x + b

The slope and intercept are calculated as:

The correlation co-efficient is calculated as:

where:

Linear Through Zero regression
Linear through zero regression assumes that the points of the standard fall on a straight line and 
that the points do line up with the zero point on the x and y axes. Use this setting to force the line 
to go through the zero point.

The linear through zero calibration equation is calculated as:

y = m x

Table 1-7 Regression Formulae

Internal Standard Used? Area Used? x y
Yes Yes Ca/Cis/DF Aa/Ais

Yes No Ca/Cis/DF Ha/His

No Yes Ca/DF Aa

No No Ca/DF Ha

m wwxy wxwy–  Dx=

b wx2wy wxwxy–  Dx=

r wwxy wxwy–  DxDy =

Dx wwx2 wx 2–=

Dy wwy2 wy 2–=
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The slope is calculated as:

The correlation co-efficient is calculated as:

If the standard points fall on a straight line and you want to average the points, then use mean 
response factor regression to produce an average of the slope for every point on the curve.

Mean Response Factor
The mean response factor calibration is calculated as:

y = m x

This is the same equation as for the linear though zero case. However the slope is calculated 
differently as:

The standard deviation of the response factor as:

Where:

If there is some linear and some curvature in the line of points, then use power regression 
instead of linear or quadratic regression to produce a line somewhere between these fits.

Power
The power function calibration equation is calculated as follows:

 

The equations for the linear calibration are used as described previously to calculate the slope 
(m) and intercept (b), except that x in those equations is replaced by ln x and y replaced by ln y. 
When this is done a, p and the correlation co-efficient (r) are calculated as:

a = exp ( b )

p = m

r = r

If the points of the standard do not fall on a straight line, use quadratic regression to produce a 
quadratic fit to the data points. This setting is frequently used.

Quadratic Calibration Equation
The quadratic calibration equation is calculated as:

Note: Points whose x value is zero are excluded from the sums.

m wxy wx2=

r wxy wx2wy2 =

m w y x  w=

 nD n 1–   w=

D wwy2 x2 wy x 2–=

y axn=

y a2x2 a1x a0+ +=
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The polynomial co-efficients are calculated as:

The correlation co-efficient as:

Where:

Report Templates
You can add the following information to report headers and footers.

Tip! Make a backup of the existing report templates before editing them.

Table 1-8 Basic Design Elements

Element Definition
Printing Date The date the document was printed.

Printing Time The time the document was printed.

Operator The operator who printed the document.

Workstation The workstation from which the document was printed from.

Page n of N Indicates the page number of total number of pages.

Custom Field Create custom text here.

Analyst Version Indicates the version of the Analyst® software.

User Type Indicates the user type (Security).

Electronic Signature Indicates whether the electronic signature feature (security) is 
enabled or disabled.

Table 1-9 Acquisition Elements 

Element Definition
Acquisition File The name of the data file with the sample acquisition information.

a2 b2 b0 b5 b3–  b1 b0 b4 b3– =

a1 b5 b3 a2b4 b3–=

a0 wy a1wx– a2wx2–  w=

r 1 ww y a2x2– a1x– a0– 2 Dy– =

Dy wwy2 wy 2–=

b0 wx w wx2 wx–=

b1 wx2 w wx3 wx–=

b2 wy w wxy wx–=

b3 wx2 wx wx3 wx2–=

b4 wx3 wx wx4 wx2–=

b5 wxy wx wx2y wx2–=
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Acquisition Date The date the sample acquisition was run.

Acquisition Time The time of the sample acquisition was run.

Operator The name of the operator who ran the sample batch.

Batch Name The name of the batch.

Sample Number The number related to the sample.

Sample Name The name of the sample.

Sample Comment Shows any comments about the sample entered through the 
Acquisition Method Editor.

Sample ID The identification number of the sample.

Scan Mode Indicates the method in which the system calculates the mass 
points for a scan for a full mass range scan.

Scan Type and Polarity Indicates the acquisition scan type (Q1, Q3, MRM, Product ion, 
Precursor ion, neutral loss/gain) and acquisition method polarity 
(positive or negative).

Scan Mass(es) Ions or ion fragments to be scanned.

Dwell Time The time the system takes to scan a particular mass.

Pause Time Indicates the pause between the scanning of mass ranges or 
between experiments.

Ion Energy Ion energy comes from the acquisition method and is related to 
the IonSpray™ ion source voltage or the collision energy.

Collision Energy Collision energy comes from the acquisition method and is 
related to the IonSpray ion source voltage.

Period and Experiment A period contains a collection of experiments; an experiment 
contains a number of properties, such as Scan Type, Scan 
Mode, Resolution, Ion Source Parameters, and a collection of 
mass ranges or masses.

State Table Parameters The mass spectrometer parameters used in the experiment.

Pump The name of the pump used for the experiment.

Autosampler The name of the autosampler used for the experiment.

Custom Annotation The custom text added via the Batch Editor.

Collected By The name of the person who collected the data.

Table 1-10 Quantitation Elements

Element Definition
Results Table Name The name of the Results Table.

Results Table Path The location of the Results Table.

Method Name The name of the quantitation method.

Method Path The location of the method file.

Project Name The name of the project.

Table 1-9 Acquisition Elements  (Continued)

Element Definition
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Customizing Reports
The Report Template Editor provides a way to customize reports by setting up headers, footers, 
and page layouts. You can use report templates with both printed output and data exported to 
another application.

Printed output includes several types of elements. 

• Window: Windows in the Analyst software appear in the working area of the 
software window, below the toolbar and to the right of the Navigation bar. When you 
print a window, you are printing everything that appears in that space.

• Pane: Panes are parts of a window arranged in such a way that they do not overlap 
and are always fully visible. For example, the Method Editor window contains two 
panes: the Browser pane and the Method Editor pane. You can print information from 
each pane in the window.

• Report: Reports are structured sets of information created in the software. Some 
reports can be directly printed, such as calibration reports; other information must be 
exported, such as batches and quantitation Results Tables.

• Workspace: A workspace is a particular arrangement of windows and panes along 
with an associated file or files. When you print a workspace, you print each open 
window and pane in the current mode. 

Previewing, Printing, and Exporting Reports
You can export acquisition methods, batches, quantitation Results Tables, and graph Results 
Tables as reports. Other forms of information, such as calculator data, can be exported but 
cannot be customized with a report template.

You can print most areas that you see on the screen. You can preview, scale, or copy graphs 
using the Print Preview feature. 

When you export a report, you save the data in a file format that is appropriate for programs such 
as Notepad, Microsoft Word or Excel, or certain LIMS (Laboratory Information Management 
System) software.

You can export reports in the following formats:

• .csv

• .doc 

• .pdf

• .txt

The formats available depend on the information being exported. For example, if you are 
exporting a graph, you can export it as a .pdf; if you are exporting a table of data, you can export 
it as a .txt file.

If you want to include additional information in the header and footer of the report, print the report 
using an appropriate template.

Results Table Name The name of the Results Table.

Table 1-10 Quantitation Elements (Continued)

Element Definition
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Results Tables
Results Tables summarize the calculated concentration of analyte in each unknown sample 
based on the calibration curve. They also include the calibration curves themselves and statistics 
for the results. 

With the software you can export the data from a Results Table to a .txt file for use in other 
applications, such as Microsoft Excel. You can choose to export all possible data in the table or 
just the data in the visible columns.

About Using Queries with Results Tables
A query is a request for records in a Results Table that the certain conditions set using textual or 
mathematical selection criteria. You can apply a query either during the process of generating a 
Results Table or after one has been generated. These two types of queries are called default and 
table-specific queries. For more information, see Default Queries and Table-Specific Queries on 
page 34.

Comparing Results Between Batches
When more than one Results Table is displayed, you can obtain statistical information on the 
standards and QCs for additional batches in the Statistics window. You normally compare results 
between batches to look for trends in the standards or QCs or to verify that the method is valid.

If you have two or more Results Tables open, you can compare results in the Statistics window. 
Both sets of statistics appear in the Statistics window.

Table 1-11 Previewing, Printing, and Exporting Reports 

To do this... ...do this
To preview a graph 1. Click File > Print Preview > Pane.

2. Edit the Print Preview dialog.
3. Click Print.

To print a report without a 
template

• Click File > Print, and then click the report that you want to 
print. 

To print a report with a 
template

1. Click File > Print & Report Setup.
2. In the Report Template section, select the template that you 

want to use and then click OK.

To export a report 1. Click File > Export.
2. In the File field, type the name of the file.
3. In the Save as type list, select the appropriate file type for the 

type of report you are exporting.
4. If you are exporting a report in Quantitate mode, select either 

All Columns or Visible Columns from the Export section 
and then click Save.

Note: The number of analytes and the number of analyte names must be the same for 
the data to be combined in the Statistics window.
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How Concentration Levels Affect Results
The concentration is defined for all QCs and standards. If there is a change in the accuracy of the 
concentration level by more than the amount defined in the Max. Variation field in the Create 
Default Query dialog, then this information appears in the Results Table.

Defining the Layout of Results Tables
The software has four predefined views of the Results Table. 

• Full Layout View

• Summary Layout View

• Analyte Layout View

• Analyte Group Layout View

If you have multiple analytes per sample, you can see each analyte in the Analyte Layout view. 
The default view is Full layout.

Full Layout View

The default Full Layout view shows the data for all analytes in the quantitation batch. The 
columns that are displayed depend on the columns selected in the Results Table Columns 
dialog, and the settings selected on the second page of the Quantitation Method Wizard.

Figure 1-13 Sample Full Layout view

Summary Layout View
The Summary Layout view contains the locked columns and the chosen field for each analyte in 
the remaining columns. For example, if you have two analytes and choose Analyte Peak Area 
from the menu, then you see the Sample Name and Analyte Peak Area columns for those 
analyte names. The Summary Layout view also includes the Formula and Custom columns, if 
these exist.
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Figure 1-14 Sample Summary Layout View

Analyte Layout View
The Analyte Layout view contains the data for a particular analyte; all other analytes are hidden. 
For example, if you choose analyte A you see all the data for analyte A. The columns that are 
displayed depend on the columns selected in the Results Table Columns dialog, and the settings 
selected on the second page of the Quantitation Method Wizard.

An Analyte Layout view, with Peak 1 selected, might look like Figure 1-15. If you compare this 
layout with the Full Layout view, you will notice that every other row has been excluded.

Figure 1-15 Sample Analyte Layout view

Analyte Group Layout View
The Analyte Group Layout view contains the data for the analytes that belong to a particular 
group. Columns that you select as shown in the Results Table Columns dialog appear in the 
Results Table as shown in Figure 1-16. Display the Analyte Peak Name column in the Results 
Table to show the names of the analytes that belong in the group.
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Figure 1-16 Sample Analyte Group Layout view

Results Table Fields
You can add columns to the standard Results Table to display DAD (diode array detector) data 
for the Analyte, Internal Standard, and Record fields. 

Formula Fields

The Formula fields display the result of a spreadsheet-style formula that you have defined.

The Formula field located at the top of the Results Table appears only if at least one Formula 
column is in the Results Table. The Formula field becomes active when Formula column cells are 
selected.

The Delete Formula Column button below the Formula field also becomes available when the 
Formula column is selected.

Custom Fields

Custom fields contain information defined during the acquisition process. When you acquire 
samples, you can create custom columns and define the type of data that goes in them. Once the 
custom column is part of the Results Table, you can treat it like any other column (for example, 
move it, hide it, base a formula on it).

Internal Standards Column Fields

The Internal Standard Results fields display information about the internal standard after 
analysis. Table 1-12 shows the available fields.

Table 1-12 Internal Standards Column Fields 

Field Definition
IS Peak Name The name of the internal standard peak.

IS Units The units in which the internal standard is given.

IS Peak Area The area of the internal standard peak.

IS Peak Height The height of the internal standard peak.

IS Concentration The known concentration of the internal standard, this 
applies to standard and quality control sample types. 
Zeroes are displayed for solvent, blank, and double blank 
sample types; N/A is displayed for unknowns.
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IS Retention Time The chromatographic retention time as determined by the 
software.

IS Expected Retention Time The retention time of the representative sample. Taken 
from the quantitation method.

IS Retention Time Window The retention time window as specified in the quantitation 
method.

IS Centroid Location The intensity-weighted average retention time for the 
analyte. The peak areas up to and after this time are 
identified.

IS Start Scan The cycle number associated with the period/experiment 
combination where the peak begins.

IS Start Time The time associated with the period/experiment 
combination where the peak begins.

IS Stop Scan The cycle number associated with the period/experiment 
combination where the peak ends.

IS Stop Time The time associated with the period/experiment 
combination where the peak ends.

IS Integration Type The method by which the baseline was found and 
integrated when the peak was found. The types are: 
manual, automatic (Baseline-to-Baseline, Valley, 
Exponential Skim, and Exponential Child).

IS Signal to Noise The signal-to-noise ratio of the peak.

IS Peak Width The ratio of the peak height to its width.

IS UV Range The UV range of the internal standard.

IS UV Channel The UV channel of the internal standard.

IS Peak Width at 50 Percent (min.) A read-only column displaying the peak width at 50% of 
peak height.

IS Baseline Slope (%/min.) A read-only column displaying the slope of the baseline.

IS Peak Asymmetry A read-only column displaying the peak asymmetry which 
is calculated by the following formula:

[(Peak End Time) – (Retention Time)] / [(Retention Time) – 
(Peak Start Time)]

Values near 1.0 indicate symmetric peaks, values greater 
than 1.0 indicate tailing peaks, and values less than 1.0 
indicate fronting peaks.

IS Processing Alg A read-only column displaying the processing algorithm 
used.

IS Integration Quality The Integration Quality™ Index indicates how well the 
peak is integrated. Values closer to 1 indicate well-
integrated peaks and values closer to 0 indicate poorly 
integrated peaks.

Table 1-12 Internal Standards Column Fields  (Continued)

Field Definition
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Record Fields

The Record fields display additional information about each sample record (information that is 
applicable only to the analyte, not the internal standard). Table 1-13 shows the available fields.

Sample Column Fields

The Analyte Results fields display information about each analyte and internal standard (if one 
was used) after analysis. Table 1-14 shows the available fields.

Table 1-13 Record Fields 

Field Definition
Use Record Indicates whether this record should be included for 

calibration. Applies to standards and QCs. If the check box is 
cleared, then the unused standards and QCs are struck out in 
the Statistics Table.

Record Modified Indicates whether the quantitation method used for the record 
was modified in any way from the original.

Calculated Concentration The calculated concentration of the analyte as calculated 
using the calibration curve.

Relative Retention Time The ratio of the retention times of the internal standard and 
the analyte.

Accuracy The calculated concentration divided by the known 
concentration (as a percentage).

Response Factor The peak area or height (depending on the regression option) 
divided by the analyte concentration.

Table 1-14 Results Tables: Sample Column Fields 

Field Definition
Analyte Peak Name The name of the analyte.

Analyte Units The units in which the analyte concentrations are given.

Analyte Peak Area The area of the analyte.

Analyte Peak Height The height of the analyte peak.

Analyte Concentration The actual, known concentration of the analyte, this applies to 
standard and quality control sample types. Zeroes are 
displayed for solvent, blank, and double blank sample types; 
N/A is displayed for unknowns.

Analyte Retention Time The chromatographic retention time as determined by the 
software.

Analyte Expected Retention 
Time

The retention time of the representative sample as taken from 
the quantitation method.

Analyte Retention Time Window The retention time window as specified in the quantitation 
method.

Analyte Centroid Location The intensity-weighted average retention time for the analyte. 
The peak areas up to and after this time are identified.

Analyte Start Scan The cycle number associated with the period/experiment 
combination where the peak begins.
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Sample Column Fields

The Sample Column fields display information about the sample that is common to all analytes. 
Blank and double blank can be defined differently from lab to lab. Table 1-15 shows the available 
fields: 

Analyte Start Time The time associated with the period/experiment combination 
where the peak begins.

Analyte Stop Scan The cycle number associated with the period/experiment 
combination where the peak ends.

Analyte Stop Time The time associated with the period/experiment combination 
where the peak ends.

Analyte Integration Type The method by which the baseline was found and integrated 
when the peak was found. The types are: manual, automatic 
(Baseline-to-Baseline, Valley, Exponential Skim, and 
Exponential Child).

Analyte Signal to Noise The signal-to-noise ratio of the peak compared to the 
baseline.

Analyte Peak Width The ratio of the peak height to its width.

Analyte UV Range The UV range of the analyte.

Analyte UV Channel The UV channel of the analyte.

Analyte Peak Width at 50 
Percent (min.)

A read-only column displaying the peak width at 50% of peak 
height.

Analyte Baseline Slope (%/
min.)

A read-only column displaying the slope of the baseline.

Analyte Peak Asymmetry A read-only column displaying the peak asymmetry which is 
calculated by the following formula:

[(Peak End Time) – (Retention Time)] / [(Retention Time) – 
(Peak Start Time)]

Values near 1.0 indicate symmetric peaks, values greater 
than 1.0 indicate tailing peaks, and values less than 1.0 
indicate fronting peaks.

Analyte Processing Alg A read-only column displaying the processing algorithm used

Analyte Integration Quality Integration Quality™ Index indicates how well the peak is 
integrated. Values closer to 1 indicate well-integrated peaks 
and values closer to 0 indicate poorly integrated peaks. This 
facilitates peak review as you can see the peaks with low 
Analyte Integration Quality values for manual review. In 
addition, you can query the data for the Analyte Integration 
Quality values that are less than a value you consider 
acceptable in order to display and manually review a subset 
of the data.

Table 1-14 Results Tables: Sample Column Fields  (Continued)

Field Definition
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Table 1-15 Sample Column Fields 

Field Definition
Sample Name The name that the user assigned to the sample when it 

was acquired.

Sample ID A user-defined identifier associated with the sample.

Sample Type All analytes within a sample must have the same 
sample type. One of the following sample types is 
displayed:

Unknown: Contains analytes whose concentrations are 
to be determined.

Standard: A sample with known analyte concentration; 
used for calibration purposes.

Quality Control: A sample with known analyte 
concentration; used to check the accuracy of the 
standard curve.

Solvent: Confirms that the instrument is clean. Solvents 
are not run through the sample preparation process.

Blank: A zero concentration sample that is not used in 
regression.

Double Blank: A sample prepared without an internal 
standard or sample analyte; confirms that the extraction 
process added nothing.

Sample Comment A comment describing the sample.

Set Number A number that identifies a subset of an entire batch.

Acquisition Method The name of the method used to acquire the samples.

Acquisition Date The date and time when the acquisition was run.

Rack Type An identifier associated with the kind of autosampler 
rack used (if any).

Rack Number The rack position in which the sample was placed when 
it was acquired. (In single-rack autosamplers, this is 
always 1.)

Vial Position The position in the autosampler plate where the vial 
was located.

Plate Type An identifier for the kind of plate used (multiplate racks 
only.)

Plate Number The plate position on the rack (multiplate racks only.)

File Name The name of the raw data file. This name is not unique 
because the data from many samples may be contained 
in a single data file.

Dilution Factor The amount by which the sample was diluted; used to 
determine the calculated concentration.

Sample Annotation Additional comments describing the sample.

Weight-to-Volume Ratio Gives the weight to volume ratio for the sample.
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Table 1-17 shows the fields that can be added to the Results Table for data acquired by an ADC 
(analog-to-digital converter).

Scripts
Research-grade scripts are available to extend the functionality of the Analyst® software. Some 
scripts are installed automatically with the Analyst software. The remaining scripts can be 
installed individually. For more information, see the Scripts User Guide for the Analyst software.

Signal-to-Noise Ratio
The signal-to-noise ratio is the peak height divided by the noise. 

To calculate the noise, the software uses the standard deviation (using a mean of zero) of all data 
points in the chromatogram from the Background Start to Background End time (both shown in 
the advanced parameters for the Quantitation Method Editor and Peak Review window.) These 
times are set when you define a new background range.

If you build a method without defining a new background range (which is possible if you accept 
the default integration with no changes), then the value for both Background Start and 
Background End is N/A. As a result, the signal-to-noise ratio is not calculated and the 
corresponding field in the Results Table reads N/A.

Table 1-16 DAD Fields 

Field Definition
Analyte Peak Area for DAD The area of the analyte peak (mAU/min).

Analyte Peak Height for DAD The height of the analyte peak (mAu).

Analyte Wavelength Ranges The range of wavelengths (nm).

IS Peak Area for DAD The area of the internal standard peak (mAU/min).

IS Wavelength Ranges The range of wavelengths (nm).

IS Peak Height for DAD The height of the internal standard peak (mAU)

Calculated Concentration for DAD.

Table 1-17 ADC Fields 

Field Definition
Analyte Channel The ADC channel from which the analyte was acquired.

Analyte Wavelength Ranges The range of wavelengths (nm).

IS Channel The ADC channel from which the internal standard was 
acquired.

IS Wavelength Ranges The range of wavelengths (nm).
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Smoothing Algorithms
You can select either the smoothing algorithm or the Gaussian smoothing algorithm as your 
smoothing method. The smoothing operation involves replacing each data point with the average 
of the data point before and after it. The smoothed data set replaces the old set.

Data can be smoothed more than once, but you can undo only the last smooth. Smoothing is not 
available for MI or MRM spectra.

Software Security
The software has a number of functions for configuring and managing security. The Analyst® 
software administrator can: 

• Choose a security mode to best suit the needs of the operating environment.

• Add and delete users and roles.

• Set access rights to users and roles as required.

• Control access to remote instrument stations.

• Control access to project files.

For more information about Analyst software security, see the Laboratory Director’s Guide.

Location of Security Information
When the software is running on a single workstation, all security information is stored in the Bin 
folder on that workstation.

When the software is running in a networked environment, the Windows security information is 
stored on the server and workstation. The security information is stored separately on each 
workstation in the bin folder.

If you are using the Administrator Console, a copy of the instrument security database is saved in 
both a local folder and a network folder. The local copy is the working copy. The network copy is 
used to replace the local copy when there are changes to the database.

Solvent Compressibility Values

Note: Projects and other files may be stored on any workstation that is part of a 
network.

Table 1-18 HPLC Solvent Compressibility Values 

Solvent Compressibility (10–6/bar)
Acetone 126

Acetonitrile 115

Benzene 95

Carbon Tetrachloride 110
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Spectral Arithmetic Wizard
You can use the Spectral Arithmetic Wizard to perform arithmetic operations using two complete 
chromatograms to create a new chromatogram, which is saved as a new data file. For more 
information, see the Help.

• Subtraction: Use the subtraction option to subtract a control or background from a 
sample.

• Addition: Use the addition option to add separate chromatograms together to create 
a single, more complete profile for a compound. For example, you could create 
several chromatograms using different collision energies and then add the 
chromatograms together to create a single profile.

• Average: Use the average option to statistically improve the profile for a compound 
and to generate more reliable spectra.

Spectrum
A spectrum is the data that is obtained directly from the mass spectrometer and normally 
represents the number of ions detected with particular mass-to-charge (m/z) values. It is 
displayed as a graph with the m/z values on the x-axis and intensity (cps) represented on the y-
axis.

Syringe Size Versus Flow Rate
The flow rate of a syringe pump depends on the syringe installed in the pump. The following 
tables show the relationship between flow rate and syringe size.

Chloroform 100

Cyclohexane 118

Ethanol 114

Ethyl acetate 104

Heptane 120

Hexane 150

Isobutanol 100

Isopropanol 100

Methanol 120

1-Propanol 100

Toluene 87

Water 46

Table 1-18 HPLC Solvent Compressibility Values  (Continued)

Solvent Compressibility (10–6/bar)
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Table 1-19 Syringe Size and Flow Rate at L/hour

Syringe size L/hour
(µL) Minimum Maximum
0.5 .002 23.8

1.0 .003 47.8

2.0 .006 95.2

5.0 .015 238.0

10.0 .029 474.0

25.0 .073 1193.0

Table 1-20 Syringe Size and Flow Rate at µL/minute 

Syringe size µL/minute
(µL) Minimum Maximum
50 .002 39.7

100 .005 79.7

250 .012 197.8

500 .024 397.0

1000 .048 795.0

1.0 .049 805.0

Table 1-21 Syringe Size and Flow Rate at mL/hour 

Syringe size mL/hour
(mL) Minimum Maximum
2.0 .011 186.8

2.5 .010 168.2

3.0 .011 181.4

5.0 .019 317.0

10.0 .028 461.0

20.0 .050 821.0

30.0 .074 1208.0

Table 1-22 Syringe Size and Flow Rate at mL/minute

Syringe size mL/minute
(mL) Minimum Maximum
50.0 .002 28.40

100.0 .003 47.60

140.0 .004 55.10
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Weighting Factors
The following table shows how the weighting factor (w in the equations below) is calculated for 
each of the seven weighting types. See also Regression on page 34.

Table 1-23 Weighting Factors 

Weighting Type Weight (w)
None Always 1.0

1 / x If |x| < 10–5 then w = 105, otherwise w = 1 / |x|. To place some additional 
emphasis on lower-value points, use a weighting factor of 1/x. 

1 / x2 If |x| < 10–5 then w = 1010, otherwise w = 1 / x2. Use a weighting of 1/x 
squared to provide a much higher emphasis on lower-value points.

1 / y If |y| < 10–8 then w = 108, otherwise w = 1 / |y|. Use a weighting factor of 
1/y when calibrating by the area (y-axis) rather than by the concentration 
(x-axis), and you want to place some emphasis on lower-value points. A 
weighting of 1/y is a variant of 1/x where y and x should be proportional to 
each other.

1 / y2 If |y| < 10–8 then w = 1016, otherwise w = 1 / y2. Use a weighting factor of 
1/y squared when calibrating by the area (y-axis) rather than by the 
concentration (x-axis), and you want to place extra emphasis on lower-
value points. A weighting of 1/y2 is a variant of 1/x2 where y and x should 
be proportional to each other. 

ln x If x < 0, then an error is generated, otherwise if x < 10–5 then w = ln 105, 
otherwise w = |ln x|. Use the logarithm of x to place more weight on 
higher value points.

ln y If y < 0, then an error is generated, otherwise if y < 10–8 then w = ln 108, 
otherwise w = |ln y|. Use the logarithm of y to place more weight on 
higher value points. Use when calibrating by the area (y-axis) rather than 
by the concentration (x-axis).
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PPG Exact Mass Table
Table 2-1 lists the exact monoisotopic masses and charged species (positive and negative) 
observed with the PPG (polypropylene glycol) calibration solutions. The masses and ions were 
calculated using the formula M = H[OC3H6]nOH, while the positive ion MS/MS fragments used 
the formula, [OC3H6]n(H+). In all calculations, H = 1.007825, O = 15.99491, C = 12.00000, and 
N = 14.00307. 

Note: When performing calibration with the PPG solutions, make sure that the correct 
isotope peak is used.

Table 2-1 PPG Exact Masses

n Exact mass 
(M)

(M + NH4)+ MS/MS 
fragments

(M + 2NH4)2+ (M + COOH)–

1 76.052 94.087 59.0 56.061 121.050

2 134.094 152.129 117.1 85.082 179.092

3 192.136 210.171 175.1 114.102 237.134

4 250.178 268.212 233.2 143.123 295.176

5 308.220 326.254 291.2 172.144 353.218

6 366.262 384.296 349.2 201.165 411.259

7 424.304 442.338 407.3 230.186 469.301

8 482.346 500.380 465.3 259.207 527.343

9 540.388 558.422 523.4 288.228 585.385

10 598.430 616.464 581.4 317.249 643.427

11 656.471 674.506 639.4 346.270 701.469

12 714.513 732.548 697.5 375.291 759.511

13 772.555 790.590 755.5 404.312 817.552

14 830.597 848.631 813.6 433.333 875.594

15 888.639 906.673 871.6 462.354 933.636

16 946.681 964.715 929.7 491.373 991.678

17 1004.723 1022.757 987.7 520.396 1049.720

18 1062.765 1080.799 1045.7 549.417 1107.762

19 1120.807 1138.841 1103.8 578.438 1165.804

20 1178.849 1196.883 1161.8 607.459 1223.845

21 1236.890 1254.925 1219.9 636.480 1281.887

22 1294.932 1312.967 1277.9 665.501 1339.929

23 1352.974 1371.009 1335.9 694.521 1397.971

24 1411.016 1429.050 1394.0 723.542 1456.013

25 1469.058 1487.092 1452.0 752.563 1514.055
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26 1527.100 1545.134 1510.1 781.584 1572.097

27 1585.142 1603.176 1568.1 810.605 1630.138

28 1643.184 1661.218 1626.2 839.626 1688.180

29 1701.226 1719.260 1684.2 868.647 1746.222

30 1759.268 1777.302 1742.2 897.668 1804.264

31 1817.309 1835.344 1800.3 926.689 1862.306

32 1875.351 1893.386 1858.3 955.710 1920.348

33 1933.393 1951.428 1916.4 984.731 1978.390

34 1991.435 2009.469 1974.4 1013.752 2036.431

35 2049.477 2067.511 2032.5 1042.773 2094.473

36 2107.519 2125.553 2090.5 1071.794 2152.515

37 2165.561 2183.595 2148.5 1100.815 2210.557

38 2223.603 2241.637 2206.6 1129.836 2268.599

39 2281.645 2299.679 2264.6 1158.857 2326.641

40 2339.687 2357.721 2322.7 1187.878 2384.683

41 2397.728 2415.783 2380.7 1216.899 2442.724

42 2455.770 2473.805 2438.7 1245.920 2500.766

43 2513.812 2531.847 2496.8 1274.940 2558.808

44 2571.854 2589.888 2554.8 1303.961 2616.850

45 2629.896 2647.930 2612.9 1332.982 2674.892

46 2687.938 2705.972 2670.9 1362.003 2732.934

47 2745.980 2764.014 2729.0 1391.024 2790.976

48 2804.022 2822.056 2787.0 1420.045 2849.017

49 2862.064 2880.098 2845.0 1449.066 2907.059

50 2920.106 2938.140 2903.1 1478.087 2965.101

51 2978.147 2996.182 2961.1 1507.108 3023.143

52 3036.189 3054.224 3019.2 1536.129 3081.185

53 3094.231 3112.266 3077.2 1565.150 3139.227

54 3152.273 3170.307 3135.2 1594.171 3197.269

55 3210.315 3228.349 3193.3 1623.192 3255.311

56 3268.357 3286.391 3251.3 1652.213 3313.352

57 3326.399 3344.433 3309.4 1681.234 3371.394

58 3384.441 3402.475 3367.4 1710.255 3429.436

59 3442.483 3460.517 3425.5 1739.276 3487.478

60 3500.525 3518.559 3483.5 1768.297 3545.5202

Table 2-1 PPG Exact Masses (Continued)

n Exact mass 
(M)

(M + NH4)+ MS/MS 
fragments

(M + 2NH4)2+ (M + COOH)–
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61 3558.566 3576.601 3541.5 1797.318 3603.562

62 3616.608 3634.643 3599.6 1826.339 3661.604

63 3674.650 3692.685 3657.6 1855.359 3719.645

64 3732.692 3750.726 3715.7 1884.380 3777.687

65 3790.734 3808.768 3773.7 1913.401 3835.729

66 3848.776 3866.810 3831.7 1942.422 3893.771

67 3906.818 3924.852 3889.8 1971.443 3951.813

68 3964.860 3982.894 3947.8 2000464 4009.855

69 4022.902 4040.936 4005.9 2029.485 4067.897

70 4080.944 4098.978 4063.9 2058.506 4125.938

71 4138.985 4157.020 4122.0 2087.527 4183.980

72 4197.027 4215.062 4180.0 2116.548 4242.022

73 4255.069 4273.104 4238.0 2145.569 4300.064

74 4313.111 4331.145 4296.1 2174.590 4358.106

75 4371.153 4389.187 4354.1 2203.611 4416.148

76 4429.195 4447.229 4412.2 2232.632 4474.190

77 4487.237 4505.271 4470.2 2261.653 4532.231

78 4545.279 4563.313 4528.3 2290.674 4590.273

79 4603.321 4621.355 4586.3 2319.695 4648.315

80 4661.363 4679.397 4644.3 2348.716 4706.357

81 4719.404 4737.439 4702.4 2377.737 4764.399

82 4777.446 4795.481 4760.4 2406.758 4822.441

Table 2-1 PPG Exact Masses (Continued)

n Exact mass 
(M)

(M + NH4)+ MS/MS 
fragments

(M + 2NH4)2+ (M + COOH)–
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